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1.About iMoney 

iMoney helps people organize and manage their personal finances quickly and easily. 

It supports all the features required for home or even small-business accounting 

needs:  

 Complete New Powerful financial methodology 

iMoney is designed to implement Enjoy Money four Rules to change financial 

struggle to happiness. Following the four rules: Happiness, Comfortable, 

Freedom and Surprise to enjoy money enjoy life. 

 Complete Picture of your financial situation 

iMoney can not only support cash account but also asset, investment, debt even 

business account. You can get a full picture of your financial, so you can control 

your money and control your life. 

 Manage multiple accounts of different types 

iMoney supports checking, savings, credit cards, loans, debt, and even your 

business accounts.  

 Create and manage budgets 

iMoney has more than 30 predefined spending categories.  

 Track performance of investments 

We have a very easy way to track 401k, Stock options, Employee Stock or any 

other investment activities. 

 Do your financial math in multiple currencies 

You can manage different currencies in just one place so you can get a perfect 

complete picture of your financial. 

 Track your spending habits and see where the money goes 

Generate any report by categories or payors/payees, including pie charts. Now 

you can see at a glance how much you spent on food last month. Find all your 

withdrawals and deposits by any parameter.  

 Easy to Use  

As powerful as the software is, it is easy to use. The personal finance software 

provides clear navigation designed to help you switch to different financial 

operation interfaces quickly. 

 Real-time Understanding of Financial Conditions 

After starting iMoney, you will know about your current financial conditions at a 

glance: current assets, current liabilities.  

 Organize and Manage Income and Expense by Category 

For each financial transaction, you can designate a category for it. The software 

provides predefined Categories that can meet the needs of most users, and you 

can also customize the categories.  

 Secure Financial Information 

You can set up password for iMoney data file. Nobody can access your financial 

information if not knowing the password.  

 Ensure You to Use Updated Version 



The software have the function of checking for updated version at any time to 

ensure you use an updated version that is more powerful and easier to use.  

 Reminders 

iMoney has three reminders, Happiness reminder, Payments reminder, 

Overspending reminders to help you to enjoy your money. 

 Target management 

If you have saving plans or saving for big bills, children, you can add a Saving 

Account to tracking all these for you. 

  



2.Get Start 

2.1. Enjoy Money Rules 

iMoney is personal budgeting software with a powerful financial methodology designed to 

implement Enjoy Money Rules of Cash Flow.  

 [Happiness] Budget for happiness 

Happiness is a choice, using your money on the point you can feel happy. With 

the meaningful stars of categories, you will feel happiness is being with you. 

   

 [Comfortable] Saving for a rainy day/goals 

Put some money aside for the rainy day, you will feel comfortable. Or saving 

money (striving) for a meaning goal will make you feel happy. When it comes 

to true you will have more money.  

 

 [Freedom] Let yourself be free  

[No debt] These days, being in debt is almost considered normal. Here is a way 

to control debt and get out of debt fast. 

[Investment] Tracking your investment and making your money work better 

for you. 

 

 [Surprise] Enjoy budget buffer 

Under Enjoy Money rules, Budget buffer will be a surprise that you can enjoy. 

Budget buffer will keep you on your budgeting happily. 

 

2.2. How can iMoney help you? 

You will have a Complete Picture of your financial situation very easily with iMoney. You can 

say “I know I Money”. Using iMoney you can: 

A. I Know iMoney 

iMoney can organize your finances all in one place, even your small business or rental 

property. 

B. I Know my expense and income 

iMoney categorizes your expenses and incomes, You’ll know exactly where you’re 

spending and where you can save. 

C. I Know my budget 

You will be free with a budget. iMoney can help you control every dollar of yours. 

D. I Know tomorrow 



 

With iMoney budget you can Save More Money and Stop Living Paycheck to Paycheck. 

 

 

  



3.Home Page 

When iMoney opens, the program starts at a main screen called the Home Page. You can return to 

this page by click the Home button at the tool bar.  

The Home Page is divided into Net Worth, Month Expense/Income, Happiness reminder, 

Target management, Overspending reminder and Budget buffer.The more financial 

information you provide to iMoney, the more iMoney can help you understand and improve your 

overall financial health. 

 

 

 

  



4.Accounts 

4.1. Understanding iMoney accounts 

You can add an account in iMoney to track almost any account you own in the real 

world. The more you include, the more closely iMoney reflects your true financial 

situation. 

iMoney can support the following types. 

iMoney Account Type Your Own Account 

Cash Your cash 

Saving Bank Accounts, PayPal etc. 

Credit Card Credit cards 

Investment Brokerage, IRA, 401(k), 529 

Debt Loan, Borrow and lend money with friends 

Asset Home, Car, Jewelry 

Business Your business 

Cash flow: cash, saving, credit card 

 Track income and expenses  

 See where your money really goes  

 Keep more accurate records  

 Balance your checkbook easily  

Investment  

 Track brokerage, IRA, 401(k), 529 etc. 

 Track all your family's investments in one place.  

 Monitor your performance. 

Debt  

 Track loan balances and payment schedules. 

 Track loan interest. 

 Track borrows and lends money from/to your friends. 

Asset 

 Track the market value of your car, Jewelry and your home. 

 Manage the income and expense of your asset. 

 Manage your rental property. 

Business 



 Track business profitability 

 See the income, expenses, and net profit or loss for each business.  

 Make a selling plan of your businesses 

 

4.2. Creating a new account 

Click the Add Account button to add your account. A pop-up will appear asking for the 

information regarding this account.  

  

Your options: 

 Select the type of account  

Choose an iMoney account type [4.1] that matches your real-world account. 

 Account name 

Enter a name for the account. The name you type will appear throughout iMoney to 

distinguish this account from others. 

 Select a currency for the account  

In order to set up iMoney to track multiple currencies, select one from the list.  

 Enter the ending date and balance from your statement  



If you know the Ending Balance, enter the appropriate date and balance for this account 

type, and then click Done. If you don't know the Ending Balance, leave the settings as 

they are (today's date, with a zero balance), and then click Done.  

 Saving Account Option 

iMoney can support three types saving accounts : Emergency Fund, Big bills and Enjoy 

and happiness.  

Saving accounts will be shown in the Target management of the Home Tab. 

4.3. Edit/Delete an account 

iMoney has Account List(Menu: Tools -> Account List) page. Use it to: 

 See an overview of all your accounts. The Account List shows all the accounts in the 

current file. From here, you can change characteristics of accounts.  

 Add a new account.  

 Edit characteristics of accounts.  

 Delete an account. 

 Hide an account. 

Caution: 

Deleting an account permanently removes that account's records from your data file. Once you 

delete an account, there's no way to recover the account or the information about your transactions 

that it contained. In addition, iMoney deletes the account name from the Category field of all 

transactions that have transfers to the account. These transactions appear as uncategorized 

transactions in reports. 

In most cases, we recommend that you hide an account instead. 

4.4. Hide an account 

If you close a real-world account and the balance is now zero, don't delete it in iMoney. You can 

save the historical data and still clean up your Account List by simply hiding the account. When 

you hide an account, it no longer appears in the Account List. You can show them again if the need 

arises. 

 To hide/unhide an account  

A. Choose menu: Tools -> Accounts List. 

B. In the Account List, Select the Account you want to hide.  

C. Click the Hide/UnHide button. 

When you hide an account, iMoney only removes the account from the Account List, but keeps 

the transactions available for reports and graphs. 



5.Transactions 

A transaction is, in simple terms, any movement of money, whether it is an outflow, inflow, 

transfer or exchange between other accounts. 

5.1. Add a cash flow transaction 

A. Go to the Account where your will be adding the transaction. 

B. Select an empty transaction at the bottom of the register. 

C. Select a Date 

D. Enter the Payee. (Optional) ( The person, place, company who paid/received the money) 

In the Payee list, you can select the Debt Account, when you select a Debt Account, the 

transaction will also be listed in the Debt Account. 

 

E. Categorize the transaction. 

F. Enter the amount of the Inflow/Outflow. 

G. In the Tag field, select a tag. (Optional) 

In the Tag list, you can select the Asset and Business Account, when you select an Asset 

or Business Account, the transaction will also be listed in the Asset or Business Account. 

 

H. In the Memo field, type a memo or note. (Optional) 

I. In the Num field, type a check number. (Optional) 

J. B field is budget date, you can change the transactions budget date with this field. 

K. Click Save button to save the transaction. 

5.2. Add a transfer transaction  

If you have set up multiple accounts in iMoney, you can transfer money between them. For 

example, if an annual bonus is deposited into your checking account, you can transfer some 

percentage of the bonus to your savings account. 

 

To add a transfer transaction is like adding a cash flow transaction: 

A. Go to the Account where your will be adding the transaction. 

B. Select an empty transaction at the bottom of the register. 

C. Select a Date 

D. In the Payee field, select a item Transfer: Account Name 

the category filed will be set to “Transfer” 

 

E. Enter the amount of the Inflow/Outflow. 

F. In the Memo field, type a memo or note. (Optional) 

G. Click Save button to save the transaction. 

Caution: 

Transfer transaction cannot have any tag value. You will receive an error message if you select a 

tag value for transfer transaction. 



 

5.3. Reconcile your cash flow accounts 

iMoney makes it easy to reconcile your bank information against your iMoney account register. 

A. Open the account register 

B. On the toolbar, click Reconcile. 

iMoney display the reconcile account dialog. 

 
C. Enter the Date, and the mount of Ending Balance. 

D. Click OK. 

iMoney will create a transaction with Reconcile as payee and Misc as category. 

Caution: 

Reconcile transaction cannot have any tag value or payee value. You will receive an error message 

if you select a tag or payee value for reconcile transaction. 

 

5.4. Enter opening balance transaction 

When you create a new account, iMoney ask you for a ending balance, if you enter the ending 

balance, iMoney will create a opening balance transaction. Normally the opening balance 

transaction is the first transaction of an account. 

You can create opening balance after an account is created. 

 

To add an opening balance transaction: 

A. Select an empty transaction at the bottom of the register. 

B. Select a Date 

C. Select the “Opening balance” category. 

D. Enter the amount of the Inflow/Outflow. 



E. In the Memo field, type a memo or note. (Optional) 

F. Click Save button to save the transaction. 

Caution: 

An opening balance transaction only can have account value or tag value. You will receive an 

error message if you set both of them. 

 

5.5. Add a split transaction 

Split transactions are useful for breaking single transactions into several categories. For example 

you may want to use a split transaction when you purchase both food and medicine at the 

supermarket. 

5.6. Edit a cash flow transaction 

If you make a mistake when entering a transaction, it's easy to enter edits and corrections. Click 

the transaction then you can edit any field of the transaction. 

 

  



6.Investment Management 

iMoney focus on the top overview of your financial. We don’t want you involved in the detailed 

investment transactions when you use iMoney. You can find that iMoney investment is a very 

simple, easy to understand way to track your investments. 

What can iMoney Investment do: 

 Track one or more investments at one or more iMoney account as you like. 

 Transfer money with other cash accounts. 

 Update balance to actual balance when you need. 

 Track analysis the performance of your investment. 

 

What iMoney investment cannot do: 

 Cannot save buy, sell and dividend transactions for investment account. (because hundreds 

of brokerage firms and banks are offering free tracking and management services online for 

clients) 

6.1. Investment transfer transaction  

Add a transfer transaction to investment account means your investment operation. You can reduce 

your investment to adding a transfer transaction to other accounts. To add a transfer transaction, 

please refer to [5.2]. 

6.2. Revaluation 

You can add revaluation transaction to update your balance. To add a revaluation balance 

transaction: 

A. Open the account register 

B. On the toolbar, click Revaluation. 

iMoney display the revaluation account dialog. 



 
C. Enter the Date, and the mount of Ending Balance. 

D. Click OK. 

iMoney will create a transaction with Revaluation as category. 

 

Caution: 

A revaluation transaction cannot have payee value or tag value. You will receive an error message 

if you set them. 

 

  



7.Debt Management 

iMoney debt management was designed to help you see your debt in the overall financial picture. 

When you add a debt account to iMoney, you associate a payee with a debt. Assign the debt payee 

when you enter a transaction, and then you’ll be able to track your debt. 

 

iMoney debt management can track two types of debt: loan(borrow money) and lend money. 

Note: Credit card is also a debt, iMoney manage the credit card as a cash flow account. 

7.1. Loan (borrow money) 

When you loan or borrow money from the bank or your friends, you will increase your debt. 

iMoney call this as Your Debt. 

 

 

A loan payment will decrease your debt. If you need pay interest, then you will have special 

expense for this loan. 

 

 

7.2. Lend money 

If you lend some money to your friends, then your creditor's rights will be increased. When you 

get a pay back then your creditor's rights will be decreased. If you get some interest, then you can 

save it as an income into an account. 



 

 

  



8.Asset Management 

Same with [  



Business Management] 

  



9.Business Management 

iMoney business management was designed to help you see how self-employment income or your 

small business contributes to your overall financial picture.  

 

When you add a business account to iMoney, you associate a tag with a business. Assign the 

business tag when you enter a transaction, and then you’ll be able to track your monthly 

business profitability and create reports that show your transactions by business. 

 

iMoney can not only manage the cash flow of your business but also the market value. You 

can use iMoney to track the market value of your business if you need. 

 

 

9.1. Manage business categories 

If you need special category for your business, you can manually add new categories. For example 

categories for rental property owners, categories for farm finances. 

 

9.2. Manage business cash flow 

Cash flow is used to track incomes and expenses, when you assign a business tag to a cash 

transaction, then you can group the transaction to this business. 

For cash transaction, please refer to [5.1]. 

 

9.3. Manage market value 

Market value is used to saving the virtual value. The market value will be show as Asset (This 

is often used when you manage your house, jewelry etc) in your overall financial picture.  

You can use revaluation function to update your business’s market value, please refer to [6.2]. 

 

  



10. Budget 

iMoney budget helps you set and change budgets. To access the budget, select tools-> Budget 

from the menu. 

10.1. Budget overview 

 

Budget page can give you a whole picture of Enjoy Money Rules. You can find the Happiness, 

Comfortable, Freedom and Surprise in one place. 

iMoney Budget will give you a clearly cash flow process when you do a budget. Firstly, all the 

money will stay in the Income Pool, and then you can assign the money to categories, saving 

account, debt or investment. 

 

 

10.2. Budget income pool 



Your income will be put to Income pool for your budget. When you assign your money to 

categories or to saving accounts, the amount of Income Pool will reduce.  

10.3. Budget for happiness 

iMoney has a metric(Stars) of happiness per dollar can help you save money and pursue what 

makes you happiest. Determining the happiness per dollar of your favorite activities can also help 

you track your hobby related spending. If you don't track and budget your spending, you can 

easily squander away a lot of your money. 

Rating categories with stars is the way to determine where you happiness are. iMoney has more 

than 30 predefined spending categories to help your complete yourself categories. You can add or 

edit the categories to match your needs. With giving stars you can know what yields the highest 

happiness you can get. 

Rate categories with Star (0, 1, 2, 3 star).  

Items Stars 

Basic Needs   No star, 1 star 

Happiness, trip, etc   2,3 stars 

Skills, Education, etc   3 stars 

Note: The balance of money and happiness is important. The information won't be perfect. Even if, 

say, vacation brings much happiness to you, it may have a low happiness per dollar ratio because 

of the high costs. It’s better when having a more satisfying life while spending less.  

 

10.4. Budget for comfortable 

When you have an Emergency Fund and you are already saving for the bills you must pay later. So 

you will feel comfortable. Or if you have meaningful goals and you are saving for that. When you 

arrive that. Not only the plan but also the achievement of your goals will make you feel happy. 

To budget for comfortable, you need create a Saving Account. After you creating the account, you 

saving account will be shown in the budget page. 

 

 



10.5. Budget for freedom 

Freedom means no debt and investment.  

iMoney can help you tracking your debt and get out of debt as soon as possible and tracking your 

investment and making your money work better for you. 

 

10.6. Budget for surprise 

Life is not easy for any of us, Budget buffer is just a surprise will let you feel happy. With budget 

buffer you can buy some things what you want (iPod, a trip, your emergency fund, debt 

repayment). Because that is the money what you can use freely. 

Why you can use budget buffer? 

 Savings and Debt: Budget for surprise base on budget for comfortable, freedom. You had 

plan money for savings (you have money for a rainy day, big bills and dream) and debt (you are 

on the way to get out of debt). 

Last month buffer: the buffer you can use is the last month’s money. It means last month 

you left some money. So you can use it freely. 

 



 

If you budget buffer is always minus, it means you set your budget up too strictly. What you need 

do is changing your budget. 

 

10.7. Envelope Management 

 

iMoney can support two types of categories monthly expense category and irregular expense 

category (Envelope). Double click the right area of a category, you can change the category type 

between Monthly expense and Irregular expense. 

 

10.8. Quick budget 

Quick budget help you create your budget quickly and easily. 

To activate Quick Budget click on the Quick Budget button at the top of the budgeted column, 

then click on a choice to select it. 



 

 

  



11. Calendar 

Transactions can be easily scheduled using iMoney Calendar. 

 

11.1. Reminders 

The scheduled transaction will remind you before it comes. The common reminders include 

automatic loan payments, estimated quarterly taxes, paychecks, rent, utility bills, etc. 

 

If there are transactions need to enter, a reminder button will appears on the right of the toolbar. 

 

Click the button, a window with the transaction list will appears. 

 

 



11.2. Add a scheduled transaction 

To add a scheduled transaction: 

A. Click the button “Add New”, the new transaction window will appears. 

B. Enter a title. 

C. Select an account where the scheduled transaction will take place. 

D. Enter the Payee. 

E. Select a category. 

F. Enter the amount of the transaction. 

G. Select the date of the first occurrence. 

H. Select the frequency of the transaction. 

I. Enter whether this transaction have a end data or not? 

 

 

  



12. Report 

The report function in iMoney enables you to view your financial data in many different ways.  

To view reports go to tools Reports.  

 

12.1. General Reports  

12.1.1. Where did I spend my money? 

Report setting: 

 

 

12.1.2. What am I worth? 

 



 

12.2. Category Reports 

12.2.1. Speeding by category 

Report setting: 

Category, date（This Month, this quarter, this year） 

 

 

12.3. Account Reports 

12.3.1. Transaction list of Account 

Report setting: 

Account，date（This Month, this quarter, this year） 

 

12.4. Budget: 

12.4.1. How much money can I use this month? 

Report setting: 



 

12.4.2. Budget by category 

Report setting: 

category，date（This Month, this quarter, this year） 

 

 

 

  



13. Data Management 

13.1. Category 

Tools menu > Category List.  

Categories track the source of a deposit (such as Salary), the purpose of an expenditure (such as 

Clothing), or the name of the account to which you're transferring funds (such as Savings). With 

categories, you can see where your money comes from and what it goes to. 

 

iMoney can better help you meet your goals if you categorize your transactions.  

 

iMoney's category List provides commonly used categories that you can customize to suit your 

needs. You can also add your category when you need. The Category List is the central location 

where you manage categories. You can add, edit, hide or delete a category or subcategory in 

Category dialog. 

 

13.2. Currency 

Tools menu > Currency List. 

iMoney was originally designed to provide a way to deal with multiple currencies in an easy and 

flexible manner.  

Every data file will have a base currency; the Home Page displays the amount base on Base 

currency.  

Every account in iMoney is assigned a currency upon creation. The transaction of cash flow, 

investment account will have the same currency with the account. But the debt and the business 

account can have different currency transactions. 

 

13.3. Payee 

For an Outflow, whoever receives the money you are spending, for an inflow, whoever pays you 

the money. 

The debt accounts are special payees. 

 

13.4. Tag 

With tags you can track a group of similar items just as a single category, with tags you need not 

clutter up your category list with a lot of additional categories.  

The business accounts are special tags. 

  

13.5. Password 

You can set a password to protect your data file 



 

To set your password for first time, please leave the Old Password field blank. 

 

13.6. Backup 

iMoney saves your data file on your hard disk each time you enter a new transaction. However, 

you should back up your data regularly so you always have a copy in case of a hardware failure or 

computer virus. 

 

 

To backup you data file: 

 File menu-> Backup 

 Select a Backup directory. 

 Click “Backup Now” 

  



14. Help and Support  

14.1. Support 

We endeavor to provide our customer with the very best quality software. But, even so our clients 

might need help. If you have any technical problem or question, our technical support team is 

always ready to assist you. 

 

You can always e-mail us at support@imoneysoft.com. When writing, be sure to include all 

relevant information so that we may help you as quickly as possible: 

 Your operation system: window xp, vista, 7; Mac; Linux. 

 Your location 

 Program version. 

 Description of the problem - as much information as possible. 

 Your OS location setting.[Window vista,7: Control Panel->Regional and language 

Options: Location] 

14.2. Registration 

Pricing: $39.95(US).  

To order, please start iMoney, choose Help->Buy Now, or use the following links:  

http://www.imoneysoft.com/buy.html 

After you pay for the program, we will send you your registration code that will allow you to use 

the purchased program without any limitations. You will be able to receive free program updates 

and you will have top priority technical support.  

 

14.3. SATISFACTION GUARANTEE 

There is a 30-DAY MONEY-BACK GUARANTEE!  

 

On our products, even though you also have 30 days to try it for free before registering! The 

30-day money-back period starts at the time of registration (purchase). If you buy now you will be 

enjoying all the benefits of the registered version within minutes! 

 

14.4. System requirements 

 

Compatible with everything (Windows, Mac, & Linux):   

Additional requirements:  

 32 MB of RAM  

 20 MB of free space on your hard disk  

mailto:support@imoneysoft.com
http://www.imoneysoft.com/buy.html


 A screen mode of 1024x768 or higher is recommended.  

  



15. Frequently Asked Questions 

15.1. I am getting an error when I try to install or update Mockups. What can I do? 

Having problems installing? Try Installing Adobe AIR[http://get.adobe.com/jp/air/] first, then 

installing the iMoney.air [http://www.imoneysoft.com/download/imoneysoft2.air] application. 

15.2. Can I get a free license? 

Yes you can, we have five methods for you to get a free 

license.[http://www.imoneysoft.com/free-license.html] 

15.3. I lost my license key. Can you email it to me? 

Certainly! Just mail us [support@imoneysoft.com].  

15.4. How to quickly and easily resize columns in the register? 

If you need to make your columns larger or smaller than the default in order to see the entire text, 

you can do that quickly using the drag to size individual columns. It is better to resize the column 

from left to right. If you resize the column from right to left, it will be a tedious thing. 

 

iMoney can save three individual columns width types: cash flow accounts(cash, bank, investment, 

credit cards),debt accounts, business accounts. For example, when you set column width for one 

bank account, then all the cash flow accounts (cash, bank, investment, credit cards) will use the 

same column width. 

Column width types iMoney account type 

Cash flow Cash, saving, investment, credit card 

Debt Debt 

Business Business, asset 

 


